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Praktische Einführung in die Finite Element Methode (FEM)

(Online-Kurs mit 6 Übungen)
Autor: Dr.-Ing. Alfred Kamusella

In dem Maße, in dem eine Technologie allgegenwärtig wird, wird sie auch unsichtbar.
Das Maß für den Erfolg einer Technologie besteht darin, wie unsichtbar sie wird.

- frei nach Kevin Kelly in NetEconomy -

Am Beispiel für Lehrzwecke kostenlos verfügbarer FEM-Programme werden in diesem Tutorial
folgende Problemkreise behandelt:

Grundlagen des FEM-Prozesses für unterschiedliche physikalische Domänen
Methodik zum Aufbau parametrisierter Finite-Element-Modelle,
Einbindung von FEM-Modellen in einen Experiment-Workflow zur Analyse und Optimierung,
Gewinnung von Übertragungsfunktionen als Ersatzmodelle für die Systemsimulation,
Strukturoptimierung von Bauteilen.

A. Präludium

Einleitung
Zielstellung der Übungen
In den Übungskomplexen verwendete Software:

FEMM-Installation
OptiY-Installation
Ansys-Installation
Autodesk Fusion (Schnellstart)

"Literatur"-Empfehlung: CADFEM-Wiki (Grundlagen zur FEM)

B. Übungsbausteine

1. FEM-Prozess (am Beispiel "flaches Bauteil")
2. 3D-Mechanik (mit Kontakten zwischen Bauteil-Oberflächen)
3. Elektrostatisches Feld (elektr. Kapazität)
4. Elektrisches Flussfeld (ohm. Widerstand)
5. Magnetfeld (Elektromagnet)
6. Optimierung mech. Strukturen mit bionischen Prinzipien

Archiv:

Beispiele für Materialdaten
Übungen (Stand 2013) mit der FEMAP-Demoversion
Übungen (Stand 2017) mit Autodesk Simulation Mechanical
Übungen (Stand 2019) mit Autodesk Inventor Professional



Übungen (Stand 2021) mit Z88-Programmen
Installation (Stand 2020) Z88-Programme
Installation (Stand 2020) AutoCAD
Beispiele mit dem FEMM-Programm
Hinweise zum Aufbau einer Autodesk-Materialbibliothek (PDF) - Autor: Felix Kirsten

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial&oldid=27906“
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Bild: Original und Finite-Element-Modell (Details von Zahnriemen und -scheibe):

 

Die Finite-Elemente-Methode (FEM) ist ein numerisches Verfahren zur näherungsweisen Lösung von
partiellen Differentialgleichungen mit Randbedingungen.

Die Lösungen dieser partiellen Differentialgleichungen beschreiben die räumliche und auch zeitliche
Verteilung der zugehörigen physikalischen Größen in einem betrachteten Raumgebiet. Man erhält im
Ergebnis für das Innere eines räumlichen Objektes z.B.:

mechanische Spannungen und Verformungen
Drücke und Strömungen
Temperaturen
Verläufe elektrischer und magnetischer Felder

Damit kann man sowohl die Belastung des betrachteten Objekts als auch seine Wirkung auf die
Umgebung berechnen. Deshalb ist die praktische Anwendung dieser Methode für Konstrukteure sehr
interessant, wenn da nicht die Hürden der Mathematik wären! Leider führt fast jede Einführung zur FEM
unweigerlich über die grundlegenden Vektordifferentialgleichungen und über die Verfahren ihrer
numerischen Lösung. Das kann den Einsteiger schon etwas abschrecken!

FEM-Simulationen in CAD-Umgebungen

Zum Glück gehört die FEM zu den erfolgreichen Technologien. Wer heutzutage mit einem modernen
CAD-System arbeitet, wird früher oder später die FEM nutzen, ohne etwas von FEM auf der
Bedienoberfläche zu sehen. Sie verbirgt sich dabei z.B. unter dem Begriff "Belastungsanalyse" und bietet
dem Konstrukteur nur die ihm geläufigen Fachbegriffe zur Konfiguration des "Belastungsexperiments",
zur Durchführung der Simulation und zur Aufbereitung der Simulationsergebnisse.

Die Möglichkeiten solcher FEM-Simulationen innerhalb von CAD-Systemen sind im Vergleich zu FEM-
Systemen zur Zeit noch begrenzt:

Häufig nur für lineare Probleme, d.h. mit konstanten Materialkennwerten.
Strukturmechanik, teilweise in Wechselwirkung mit Temperaturfeldern.
Häufig schon Strömungsmechanik, zugeschnitten auf Spritzguss-Probleme.
Kaum Möglichkeiten zur Nutzung unterschiedlicher Finite-Element-Typen.
Die Generierung des FE-Modells aus dem CAD-Modell erfolgt automatisiert. Die



Berechnungsgenauigkeit kann dabei durch Parameter für die globale und lokale Vernetzungsdichte
beeinflusst werden.

In modernen CAD-Systemen ist die FEM für den Nichtspezialisten bereits soweit aufbereitet, dass er
damit viele seiner alltäglichen Dimensionierungsprobleme weitestgehend lösen kann.

"Nichtspezialist" für FEM bedeutet jedoch auch dann nicht, keinerlei Wissen über die Grundprinzipien
und Fehlermöglichkeiten der FEM-Simulation besitzen zu müssen. Erforderlich sind folgende
Grundkenntnisse:

Ist ein linearer Ansatz im Sinne der erforderlichen Genauigkeit überhaupt zulässig?
Sind die Vereinfachungen bei der Definition der Randbedingungen (Lager, Kräfte usw.) zulässig?
Welche geometrischen Details des CAD-Modells sind kritisch in Hinblick auf die Bildung eines FE-
Modells?
Welche Auswirkungen haben die Möglichkeiten zur FEM-Konfiguration?
Welche Probleme existieren bei der Darstellung und Interpretation der Simulationsergebnisse?

Fehlt dieses erforderliche Grundwissen, so ist die Gefahr einer Fehlinterpretation der erhaltenen
Ergebnisse sehr groß. Z.B. lässt sich die Richtigkeit der berechneten Belastungen und Verformungen
komplexer Bauteile nur mit "gesundem Menschverstand" im Detail nicht immer überprüfen.

Simulationen in FEM-Systemen

In absehbarer Zukunft wird es immer FEM-Probleme geben, welche man mit den in CAD-Systemen
"versteckten" FEM-Tools nicht lösen kann. Ein repräsentatives Beispiel sind die Belastungen von
Zahnriemen unter verschiedensten Betriebsbedingungen:

Die Materialeigenschaften des Zahnriemens sind Belastungs- und Richtungsabhängig. Es handelt
sich deshalb um ein nichtlineares Problem.
Die Randbedingungen (Eingriff der Zähne des Riemens in die Scheibe) sind abhängig von der
Riemen-Verformung und dem Drehwinkel der Scheibe. Normale Lagerstellen können diese
Abhängigkeiten nicht abbilden.
Der im Riemen-Elastomer eingebettete Zugstrang erfordert spezielle Maßnahmen bei der Bildung
des FE-Modells.
Die Simulation der Getriebe-Bewegung erfordert eine Vielzahl einzelner FE-Simulationen mit
schrittweise verändertem Drehwinkel der Riemenscheibe.
... und viele Probleme mehr!



In solchen Fällen hilft nur der Übergang vom CAD-System zu einem ausgereiftem FEM-System. Anstatt
des CAD-Modells mit Geometrie- und Materialeigenschaften arbeitet man im FEM-Programm mit einem
2D- oder 3D-Netz Finiter Elemente.

Neben der Bedienung des FEM-Systems sind nun umfangreichere Kenntnisse zur Methode der Finiten
Elemente erforderlich:

Bild: FEMAP mit NX-NASTRAN
Quelle: Siemens PLM Software

Welche Modell-Elemente sind für das konkrete Problem geeignet?
Welche Vereinfachungen der Geometrie sind erforderlich bzw.
zulässig, um dass Problem überhaupt mit der FEM behandeln zu
können?
Wie sind die Randbedingungen definierbar?
Wie ist das FE-Netz aufzubauen, damit in möglichst kurzer Zeit
hinreichend genaue Ergebnisse berechnet werden?
Wie ist mit der gleichen Zielstellung der Gleichungslöser zu
konfigurieren?
...

Obwohl alle FEM-Systeme letztendlich mit einem FE-Netz arbeiten, bieten sie dem Anwender
unterschiedlichste Benutzer-Oberflächen:

Je universeller die Möglichkeiten eines FEM-Systems sind, desto stärker orientiert sich die
Funktionalität an der Bearbeitung von FE-Netzen (Editieren von Knoten, Elementen, Subnetzen).
Je spezialisierter ein FEM-System in Hinblick auf die physikalischen Domänen oder den
Benutzerkreis ist, desto mehr orientiert sich die Funktionalität am Anwendungsbereich bzw. an der
Benutzergruppe (Editieren von Geometrie, Benutzung fachspezifischer Begriffe, Tendenz zum
automatisierten Vernetzen).

Wer mit FEM-Systemen simuliert, sollte über das erforderliche Erfahrungswissen in einer möglichst
allgemeinen Form verfügen. Die Grundlage dafür bietet der verallgemeinerte FEM-Prozess auf Basis des
FE-Netzes. Dann existieren erfahrungsgemäß auch kaum Probleme bei der Einarbeitung in ein neues
FEM-System.

Entwicklung eigener Element-Typen

FEM-Systeme stellen Bibliotheken von Element-Typen für die FE-Netze bereit. Diese Element-Typen
entstanden im Verlaufe von Jahren auf Grund unterschiedlichster Anforderungen der Nutzer (2D/3D-
Probleme, Axialsymmetrische Probleme, diverse Belastungsfälle der Strukturmechanik usw.).

Neue Element-Typen benötigt man nur, wenn man ein neues Feldproblem bearbeitet, für das im FEM-
System noch keine Element-Typen existieren. Dies könnte erforderlich sein, wenn man z.B. in
Nanostrukturen mit ihren Quanteneffekten vorstößt. Erst dann benötigt man dafür die gesamte Theorie,
die man in den so genannten Einführungen zur FEM erhält. Die numerische Umsetzung der
theoretischen Grundlagen erfordert Tage- bis Monatelanges Programmieren, bis ein neuer Element-Typ
funktioniert.

Der normale FEM-Nutzer wird mit diesen anspruchsvollen Aufgaben kaum konfrontiert werden. Solche
Entwicklungen bleiben Spezialisten vorbehalten, die sowohl über das nötige theoretische Rüstzeug als
auch über tiefgründige Erfahrungen im Umgang mit FEM-Systemen verfügen müssen.



← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_Einleitung&oldid=23631“
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Zielstellung der Übungen

In der vorangestellten kurzen Einleitung wurde angedeutet, über welche Kenntnisse ein FEM-Anwender
verfügen sollte. Das ist davon abhängig, auf welchem Niveau er die FEM nutzt:

1. FEM-Simulationen in CAD-Umgebungen
2. Simulationen in FEM-Systemen
3. Entwicklung eigener Element-Typen

Nach dem Durcharbeiten der folgenden Übungsaufgaben hat man noch nicht das erforderliche Wissen,
um eigene Element-Typen für FEM-Systeme zu entwickeln!

Ziel ist vielmehr die Vermittlung eines grundlegenden Verständnisses für die qualitativen
Zusammenhänge bei der Anwendung der FEM. Das ermöglicht dem Nutzer:

den schnellen Einstieg in die praktische Anwendung der FEM unter den verschiedenen
Umgebungsbedingungen;
die kompetente Wertung der Modell-Ansätze und der Simulationsergebnisse;
einen sinnvollen Einstieg in die theoretischen Grundlagen der FEM und ihrer numerischen
Umsetzung.

Vorausgesetzt wird dabei ein grundlegendes Verständnis für die mit der FEM behandelten physikalischen
Domänen (Mechanik, Wärme, elektrische und magnetische Felder). Dafür reicht zur Not schon das
Schulwissen, eine gewisse Vertiefung durch das Grundstudium in den Ingenieurwissenschaften ist jedoch
von Vorteil.

In Hinblick auf die probabilistische Simulation und Optimierung bestehen die Ziele der Übungen in der
Vermittlung einer Methodik für

1. die Parametrisierung von FE-Modellen durch die Nutzung von Script-Sprachen.
2. die Einbindung von FE-Modellen in die System-Simulation auf der Basis von Ersatzmodellen.

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_Zielstellung&oldid=5923“
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Verwendete Software

Bei der Auswahl der für die Übung genutzten Software wurden folgende Aspekte berücksichtigt:

1. Transparenz des FEM-Prozesses für den Nutzer.
2. FEM-Fachsprach-Niveau für die Begriffe auf der Benutzeroberfläche.
3. Reproduzierbarkeit der typischen Fehlermöglichkeiten bei der FEM-Anwendung.
4. Kopplung von CAD- und FEM-Modell innerhalb einer CAD-Umgebung.
5. Einbindung der FEM-Simulation in eine Analyse- und Optimierungsumgebung sollte möglich sein.
6. Beschaffung und Nutzung der Software von allen Interessenten ohne großen zeitlichen und

finanziellen Aufwand.

Die Wahl fiel nach einigen Recherchen auf ein 3D-CAE-System, ein 3D-CAD-Programm, zwei FEM-
Programme (Struktur-Mechanik bzw. elektro-magnetische Felder) sowie ein Analyse- und
Optimierungstool. Dieser Umfang gewährleistet eine praxisrelevante Einführung in die vielen Facetten
der FEM-Anwendung.

Autodesk Fusion:

Autodesk bemüht sich mit großem Aufwand um einen engen Kontakt zum Ingenieurnachwuchs. Schüler
und Studenten können kostenlos auf eine breite Produktpalette zugreifen. Voraussetzung ist eine
Registrierung bei Internetportal www.autodesk.com/education.

Autodesk Fusion (ehemals Fusion 360) ist seit einigen Jahren der Versuch von Autodesk, eine möglichst
umfassende, aber einheitliche Plattform für den Konstruktionsprozess von ersten Designstudien bis zur
rechnerunterstützten Fertigung zu entwickeln:

Bei diesem Programm handelt es sich um ein grundlegend neu konzipiertes Produkt, in welches
schrittweise alle erforderlichen Funktionen integriert werden.
Hierbei orientiert man sich primär an der Funktionalität von Autodesk Inventor, welche man durch
bewährte Funktionen aus anderen Autodesk-Programmen ergänzt.
Zusätzlich dient Fusion den Autodesk-Entwicklern als "Spielwiese" zum Erproben und
Implementieren neuer Konzepte. Die Entwicklung ist also noch im vollen Fluss!
Inzwischen hat das Programm einen Stand erreicht, dass man es für diejenigen Teilprozesse sehr gut
nutzen kann, welche nicht das Erstellen "Technischer Zeichnungen" als Hauptziel verfolgen.
Die für die Erstellung der CAD-Modelle mit Autodesk Fusion erforderlichen Bearbeitungsschritte
werden im Rahmen des FEM-Tutorials detailliert beschrieben. Vorkenntnisse sind hierfür nicht
erforderlich.

FEMM_4.2:

Es handelt sich um ein FEM-Programm zur Berechnung von 2D- und axialsymmetrischen
Problemen:

niederfrequente magnetische Felder
elektrostatische Felder



elektrische Flussprobleme
Wärmeleitungsprobleme.

Dieses FEM-System wurde von David Meeker entwickelt.
Neben den numerischen Qualitäten dieses Programms spricht auch der "Freeware"-Status für den
Einsatz zu Lehrzwecken. Es kann kostenlos unter www.femm.info/wiki/HomePage geladen
und als Vollversion genutzt werden.
Da es sich hierbei um ein "spezialisiertes" FEM-Programm handelt, tritt der allgemeine FEM-
Prozess nicht mehr so deutlich in den Vordergrund. So erhält man also bereits im Rahmen dieser
Übungen einen Eindruck von unterschiedlichen Benutzeroberflächen.

OptiY (Analyse- und Optimierung):

OptiY® ist eine offene und multidisziplinäre Entwurfsumgebung, welche modernste
Optimierungsstrategien und probabilistische Algorithmen zur Unsicherheits- und Sensitivitätsanalyse,
Robustheitsbewertung, Zuverlässigkeitsanalyse, Lebensdauerberechnung, Data-Mining und Meta-
Modellierung bereitstellt.
Die Modelle, auf deren Basis die Optimierung erfolgen soll, werden dabei als Blackbox mit Ein- und
Ausgangsgrößen betrachtet. Damit ist es ein offenes System für unterschiedlichste Modellklassen.
Die Anpassung an eine spezielle Modellumgebung erfolgt über die Schnittstellen. Möglich ist das
Zusammenwirken mit verschiedenen CAD- und CAE-Systemen (z.B. für Netzwerkanalogien, Finite-
Element-Methode, Starrkörper-Dynamik) aber auch mit "materiellen" Versuchsständen (z.B. Regler-
Optimierung für Antriebsysteme).
Wichtig: Teilnehmer der FEM-Lehrveranstaltung erhalten die zu verwendende OptiY-Version
vom Betreuer! Andere Interessenten können im OptiY-Webportal eine Trial-Version anfordern,
deren Funktionsumfang für die Bearbeitung der Übungsbeispiele ausreichend ist.

Ansys Student:

Ansys Student ist die frei verfügbare Studentenversion der Softwaresuit von ANSYS Inc.
Über die sogenannte Workbench werden seit einigen Jahren die verschiedenen
Simulationsumgebungen des Unternehmens miteinander verknüpft.
Das Paket ist extrem umfangreich und lädt zum selbstständigen Experimentieren ein.
In diesem FEM-Tutorial wird hauptsächlich die Komponente Mechanical für thermische und
mechanische Simulationen eingesetzt.
Die Studentenversion enthält eine integrierte Lizenz, die die Größe von FE-Modellen auf maximal
128.000 Knoten begrenzt. Diese Einschränkung ist akzeptabel, um ein weit verbreitetes
Softwareprodukt besser kennenzulernen. Außerdem ist man damit automatisch gezwungen, auf die
Größe der eigenen Modelle zu achten.

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_Software&oldid=28725“
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FEMM 4.2 - Installation
(Download der Software)

Es wird zwar noch eine 32-Bit-Version des Programms bereitgestellt. Möchte man FEMM in der
Analyse- und Optimierungsumgebung des 64-Bit-Programms OptiY nutzen, sollte man die 64-Bit-
Version wählen. Nach Akzeptieren der Lizenz-Bedingungen kann man das Programm im
angebotenen Standard-Ordner installieren.
Wichtig:

Die Frage "Do you want to install FEMM with Mathematica support?" muss man mit "Nein"
beantworten. Sonst wird bei jedem FEMM-Start versucht, die Mathematica-Schnittstelle
ML32I2.dll zu laden, die nur existiert, wenn auf dem PC das Mathematica-Programm installiert
ist.
Den ersten Programm-Start muss man "Als Administrator ausführen", um das COM-
Interface korrekt zu initialisieren!
Wenn man sich einmal im Administrator-Modus befindet, sollte man unter Edit >
Preferences > General Attributes das standmäßig für alle Modell-Dateien aktive Smart
Meshing deaktivieren, weil dies nur als Administrator möglich ist (anderenfalls bleibt die
Umschaltung ohne Wirkung!):

Nach dem Start von FEMM beginnt man die Arbeit mit einer neuen Datei (File > New), für
welche man zuerst die Art des Problems definieren muss:

Es erscheint danach das an die Problemstellung angepasste Benutzer-Interface:



Im Dialog zur Problem-Definition ist standardmäßig die globale Einstellung für die Smart
Meshing-Option eingetragen. Hier kann man bei Bedarf auch ohne Administrator-Rechte für das
aktuelle Modell das Smart Meshing Ein-/Ausschalten.
Das Smart Meshing verfeinert das Netz an allen Ecken, weil an Eck-Knoten die größten
Feldgradienten zu erwarten sind. Die globale Vernetzung ist ebenfalls sehr fein (Teilung von ca. 50
in Bezug auf Umrandungslinien von Bereichen). Man gelangt damit automatisch zu einem Netz mit
sehr guter Genauigkeit für die Simulationsergebnisse.
Solange man FEMM nur für einzelne, manuell gestartete Simulationen benutzt, ist trotz der feinen
Vernetzung des Smart Meshing die resultierende Rechenzeit für 2D-Probleme nicht störend.

Wir werden in den Übungsbeispielen das Smart Meshing abschalten (falls es global noch aktiv ist):

1. Nur durch die manuelle Steuerung der Vernetzung kann man ein Gefühl für die Auswirkungen der
Vernetzungsdichte entwickeln.

2. Bei Einbindung des FEMM-Programms in eine Analyse-/Optimierungsumgebung ergeben sich sehr
viele Modellberechnungen. Dazu ist im Sinne der Berechnungszeit ein Kompromiss zwischen
Vernetzungsdichte und Berechnungsgenauigkeit erforderlich, welcher durch Smart Mesh meist nicht
erreicht wird.

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_FEMM-
Installation&oldid=24885“
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OptiY - Installation

(Bei Bedarf eine Trial-Version anfordern)

Wichtig: Teilnehmer der FEM-Lehrveranstaltung erhalten die zu verwendende OptiY-Version vom
Betreuer!

.NET Framework 4.6 oder neuer wird von OptiY vorausgesetzt. Dieses ist normalerweise ein
Bestand des Betriebssystems MS Windows. Falls dies nicht der Fall ist, kann man diese Software
kostenlos von der Microsoft Website herunterladen.
Registrierung als COM-Objekt im Windows erfordert einen einmaligen Start von OptiY mit
Administrator-Rechten nach der Installation:

Unter Eigenschaften - Kompatibilität des Programms (Kontextmenü der rechten Maustaste
auf OptiY-Symbol z.B. auf dem Desktop) wählt man die Berechtigungsstufe "Als Administrator
ausführen".
Nach Beenden von OptiY muss diese Administrator-Berechtigung in den
Kompatibilitätseigenschaften wieder deaktiviert werden!

Nutzung hochauflösender Displays:
Viele Programme haben Probleme mit extrem hochauflösenden Bildschirmen, wie sie verstärkt
z.B. in modernen Tablett-Computern zum Einsatz kommen. In OptiY äußert sich dies in
teilweise unlesbar kleinen Diagramm-Legenden oder sich überlappenden Listen-Elementen.
Abhilfe schaffen hier die Kompatibilitätseinstellungen (Kontextmenü des OptiY-Icon auf dem
Desktop) "Hohe DPI-Einstellungen ändern":

Es ist der Modus "Verhalten bei hoher DPI-Skalierung überschreiben" zu aktivieren und
"Skalierung durchgeführt von System" einzustellen. Danach sollten alle Programm-



Komponente in aufeinander abgestimmter Skalierung dargestellt werden.
Umschalten der Bedienoberfläche auf die Sprache "Deutsch" (um Konsistenz mit den
deutschen Übungsanleitungen herzustellen):

Tools > Options > Language > Deutsch

Danach OptiY beenden, da erst nach erneutem Start die Sprache der Oberfläche komplett
umgeschaltet ist.

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_OptiY-
Installation&oldid=26706“
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Ansys Student - Installation

(Download der Software)

Für die Teilnehmer der Lehrveranstaltung ist diese Software natürlich schon im
PC-Kabinett installiert. Für den privaten Gebrauch muss man sich das
Ziparchiv bei Ansys herunterladen:

Wichtig: falls bereits eine ältere Version der Software vorhanden ist sollte
diese vor der Installation entfernt werden.
Das heruntergeladene Archiv entpacken (kann nach der Installation wieder
gelöscht werden).
Für die Installation werden etwa 70 GB freier Speicherplatz auf dem PC
benötigt.
Im entpackten Ordner ganz nach unten scrollen und "setup.exe" starten.
Dem Installationsassistenten folgen und auf Abschluss des Setups warten.
Sobald der Fortschrittsbalken 100 % erreicht und man die Meldung "Die
Installation ist abgeschlossen" sieht, kann man unten rechts auf Beenden
klicken.
Ansys umfasst inzwischen eine sehr große Anzahl an Subkomponenten und
-systemen. erfahrene Nutzer können hier gleich mit dem passenden
Programm ihre Arbeit beginnen. Für unsere Übung wird der
Ausgangspunkt immer die "Workbench 20xx Rx" sein. Diese kann man
sich im Startmenü oder auf dem Desktop verlinken (auch die
Windowssuche nach "Workbench" funktioniert recht gut).
Nach dem ersten Start wird man gefragt, ob Nutzerinformationen zur
Produktverbesserung weitergegeben werden sollen. Hier kann man selbst
entscheiden, es entstehen keine Nachteile.

← →

Abgerufen von „http:///index.php?title=Software:_FEM_-_Tutorial_-_Ansys-
Installation&oldid=28727“



Software: CAD - Tutorial - Fusion
Aus OptiYummy

↑ zurück zu CAD ↑ zurück zu FEM

Autodesk Education Account & Fusion-Installation

Inhaltsverzeichnis

1 Anlegen eines Autodesk Education Accounts

1.1 Standard-Installation

2 Nutzung der Webversion in einem HTML5-kompatiblem Browser

3 Erster Programm-Start

Anlegen eines Autodesk Education Accounts

Wichtig:

Für den Download und die Nutzung von Fusion ist ein verifizierter Autodesk-Account mit
Bildungslizenz notwendig!
Im Anschluss an das Erstellen und Verifizieren des Accounts muss einmalig der Download von
Fusion gestartet werden, damit die Lizenz dafür mit dem Konto verknüpft wird. Der Download
reicht aus, eine Installation ist nur bei aktiver Nutzung auf dem konkreten Gerät nötig.
Die Modalitäten für die Registrierung ändern sich praktisch jährlich.
Der Verfasser dieser Anleitung (der bereits seit längerer Zeit eine Bildungslizenz besitzt) kann kaum
überprüfen, welche Schritte der Einsteiger jeweils absolvieren muss.
Die folgende Beschreibung widerspiegelt den jeweils aktuellen Erkenntnisstand, der im Detail aber
etwas abweichen kann!

Voraussetzung ist eine Registrierung beim Internetportal www.autodesk.com/education/ als Student:

Beachte: Um die berechtigte Nutzung der Produkte und Services sicherzustellen, auf die kostenlos
über die Autodesk Education Community zugegriffen werden kann, hat Autodesk aktuell SheerID (eine
Identitätsmarketingplattform) damit beauftragt, die Berechtigung der Nutzer für den kostenlosen
Zugang zu überprüfen. Dabei kann man Online aus einer Liste die eigene Bildungseinrichtung
auswählen (sofern diese sich am SheerID-Verfahren beteiligt). Man muss über ein gültiges Login für
die betreffende Bildungseinrichtung verfügen, die Eingabe der Zugangsdaten erfolgt direkt auf dem
Server der Bildungseinrichtung und Autodesk erhält dann nur eine Bestätigung über den Status des
Nutzers.
Bei Bedarf kann man in einer von Autodesk bereitgestellten Präsentation den gesamten Prozess der
Registrierung (PDF) (mit Stand Juni 2023) detailliert nachlesen.

Erfahrungen zu Problemen bei der Berechtigungsprüfung:

Im verwendeten Browser müssen während der Berechtigungsprüfung eventuelle Werbeblocker
deaktiviert sein, weil diese zum Beispiel den Zugriff auf die Datenbank der eingetragenen
Hochschulen blockieren.



Die Wahl der Bildungseinrichtung muss aus der Dropdown-Liste erfolgen (KEINE manuelle
Texteingabe in dem zugehörigen Textfeld!).
Wird an der Hochschule mit Shibboleth gearbeitet, erfolgt bei richtiger Wahl der Hochschule eine
Weiterleitung an das Single Sign-On der Bildungseinrichtung (ohne zusätzlicher Abfrage von
Unterlagen). Leider taucht z.B. die TU Dresden 2x in der Auswahlliste auf. Man muss hier den
"richtigen Eintrag" wählen (im folgenden Bild gelb markiert), damit eine direkte Weiterleitung an das
Prüfverfahren erfolgt:

Beteiligt sich die gewählte Bildungseinrichtung nicht an diesem Single Sign-On-Prüfverfahren oder
kommt es zu Problemen bei der Identifizierung, so wird man aufgefordert, entsprechende
Unterlagen zum Nachweis der Berechtigung hochzuladen. Das wäre z.B. eine Kopie des aktuellen
Studentenausweises oder der Immatrikulationsbescheinigung. Nach Überprüfung dieses Dokuments
erhält man dann die Berechtigung innerhalb kurzer Zeit (nach Aussage eines Autodesk-Mitarbeiters
innerhalb von Minuten).

Standard-Installation

Man kann nach Anmeldung bei Autodesk unter Microsoft Windows die Software für Fusion
"Herunterladen". Unter "Plattform" kann oben auch MacOS gewählt und der entsprechende Installer
für Apple-Geräte heruntergeladen werden. Danach startet man die Installation von Autodesk Fusion im
benutzereigenen Ordner auf dem Computer:

Falls es hierbei Probleme gibt, hilft vielleicht die Erfahrung aus dem letzten Jahr:
Das Installationsprogramm "Fusion Client Downloader.exe" sollte man auf dem eigenen
Computer speichern, bevor man es ausführt.
Nach dem Starten dieses Web-Installers wird die aktuelle Fusion-Version geladen und im
eigenen Nutzerverzeichnis im Ordner "AppData" installiert.

Die Installation umfasst mehrere Gigabyte. Nach jedem Start von Fusion werden vorhandene
Updates sofort eingespielt, sodass man immer mit der aktuellsten Version arbeitet. Für die
Aktualisierung genügen die normalen Benutzer-Rechte, da alles im eigenen Nutzerordner stattfindet.
Falls auf einem PC mehrere Nutzer Fusion360 mit ihrem individuellen PC-Account verwenden
möchten, so wird für jeden Nutzer die komplette Fusion-Installation unabhängig voneinander
"gepflegt".

Hinweis für Linux-Nutzer:

Eine vollwertige Linuxversion von Fusion gibt es leider nicht. Der einfache Weg ist das Nutzen der
Browserversion (siehe unten).
Es ist möglich über Wine die Windows-Version zu nutzen. Dazu findet man eine Anleitung mit
Installationsskript auf Github.
Für die konkreten Einrichtungsschritte in zahlreichen Linux-Versionen kann dieses Tutorial aus
Aufwandsgründen leider keine vollständige Anleitung liefern.

Nutzung der Webversion in einem HTML5-kompatiblem Browser

Auf Computern, welche nicht über ein 64-Bit-Windows als Betriebssystem verfügen, kann man ohne
Installation von zusätzlicher Software Autodesk Fusion direkt im Web-Browser nutzen:
https://fusion.online.autodesk.com/. Dazu sind folgende Voraussetzungen erforderlich:

verifizierter Autodesk-Account mit Bildungslizenz
moderner HTML5-kompatibler Web-Browser



stabile Internet-Verbindung (Mindestbandbreite 5 Mbit/s Download und 1,5 Mbit/s Upload)
Computer mit ausreichend freiem Hauptspeicher (4 GByte RAM?)

Der erste Start der Webversion dauert relativ lange, weil zuerst die erforderlichen Komponenten der
Fusion-Webapp geladen werden.

Hinweis: Eine Umschaltung der Nutzer-Sprache von "englisch" auf "deutsch" ist in den Einstellungen
möglich und soll nach einen anschließenden Neustart der Webversion wirksam werden. Leider blieb
danach das Benutzer-Interface trotzdem in Englisch!

Weitere Hinweise: FAQ zur Nutzung der Web-Version

Erster Programm-Start

Unabhängig von der benutzten Fusion-Version gelangt man nicht direkt in die Programm-Oberfläche,
sondern muss sich zur mittels seines Autodesk-Accounts anmelden:

Anstatt der geforderten E-Mailadresse kann man auch seinen Autodesk-Nutzernamen für die
Anmeldung verwenden.
Nach der ersten Anmeldung wird man auf die Möglichkeit der 2-Step Verification zur Erhöhung der
Zugangssicherheit hingewiesen. Dieser Aufwand ist im Rahmen dieser CAD-Übung sicher nicht
erforderlich und der Hinweis kann mit "Remind me later" quittiert werden.

→ weiter zu CAD
→ weiter zu FEM

Abgerufen von „http:///index.php?title=Software:_CAD_-_Tutorial_-_Fusion&oldid=28728“


